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Some tips and tricks for using ELAN

The purpose of this guide is to provide fieldworkers with the basic knowledge they need to start
using ELAN and to use ELAN in conjunction with other useful software, specifically Praat and
FLEx. There are many ways that fieldworkers can use ELAN, Praat, and FLEx for transcription,
annotation, interlinearization, and other analysis. This guide presents one possible workflow
where transcriptions and translations are created in ELAN, Praat is used for clipping tokens or
spot-checking transcriptions, and FLEX is used for interlinearization.

This guide covers the following:

1. How to get started using ELAN (for those who do not already use it)

2. How to design a tier structure and create a template for it in ELAN

3. How to export from ELAN to FLEx

4. How to import Praat TextGrids to ELAN (and vice-versa) and link Praat with ELAN

This document is basically a brief distillation of the User Guide for ELAN Linguistic Annotator
(written by Maddalena Tacchetti, October 2013 version') and “Working with ELAN and FLEx
together: and ELAN-FLExX-ELAN traching set” by Tim Gaved and Sophie Salffner (January
2014 version?). The basic template that I use for exporting from ELAN to FLEX is a simplified
version compared to the one used in Gaved and Salffner’s teaching set. The template used here
only works for exporting from ELAN to FLEx and does not permit exporting FLEx
interlinearizations back into ELAN. Gaved and Salffner’s guide provides a thorough description
of exporting data from FLEx back into ELAN.

1 Getting Started with ELAN — just the basics!

ELAN is software for transcribing and annotating audio and video recordings. ELAN has five
modes for different stages of the annotation process:

e Annotation Mode: provides a top-down view of all annotations (e.g., transcriptions,
translations, notes), but is not very useful for entering data or making changes

e Media Synchronization Mode: for use with projects that involve both audio and video

e Segmentation Mode: for dividing a recording up into segments that will be annotated

e Transcription Mode: for entering transcriptions and other time-aligned annotations

¢ Interlinearization Mode: a new mode in ELAN 5 and higher that includes parsing and
lexicon capabilities

This section explains how to create an .EAF file, segment a recording, and enter a transcription
in ELAN. Media Synchronization and Interlinearization are not described in this guide, but there
are many excellent resources online to learn more about these and other features of ELAN.

! The most recent version at this writing is from December 2018, available online at:
https://www.mpi.nl/corpus/html/elan_ug/index.html

2 The most recent version at this writing is from November 2015, available online at:
http://www.mpi.nl/tools/elan/tp/how-to/ELAN-FLEx-ELAN 2015-11-06.zip
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There are many different ways to incorporate ELAN into a project’s workflow. A minimal
workflow is likely to include the following steps:

Create a recording

Segment the recording

b=

Open the recording and template in ELAN

Transcribe and annotate the recording

In reality most workflows will involve additional steps including changes to the segmentation
and annotations, and imports/exports from/to other software like Praat or FLEx, which are

covered in later sections.

1.1 Opening a file in ELAN for the first time

When you open ELAN for the first time you will notice that there is almost nothing on the
screen. To start a new .EAF annotation file, click File > New. This will open a window:

File Name iTempIate_vaa—es.etf

File Fom:a!|

2 New X
Lookin: |[J|= @ @ @ Selected Files:
[} yaa_2018-01.01_MRR_KCN_0001.wav|
»>
Select
8 Media
) Template
File Name | | | || T || L |
File Fom:a]iﬂommon Media Files {*.mpg, *.m | Add Streaming File... |
[ on |[ucemenal
2 New *
Look in : ﬁl - @ @ @ Selected Files:
[} Template_yaa-es.etf | C:Userslkelse\DesktopiEx:
D Template_yaa-es.pfsx A
D yaa_2018-01-01_MRR_KCN_0001.wav \L‘
Select
) Media
s Template
of 1 [®
EdENEN

| Add Streaming File... |

| 0K || Cancel |

Navigate to the folder where
your recording is located, click
it, then use the “>>’ button to
add it to the file list on the
right.

Select the ‘Template’ button
and navigate to the folder
where your project ELAN
template is located. Select the
template and add it by clicking
“>>’ as above.

Clicking ‘OK’ will open your
audio file and first .EAF file in
Annotation Mode, which is
basically the master viewing
mode.
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It should look something like this:

2 ELAN 5.2 - Undefined File Name — O >
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Note: the tier template used in this example is one designed for exporting to FLEx — your project
template may differ.

Don’t forget to save your file with a name that refers to the recording and to a location that you

can easily find. Note: ELAN does not always handle file names with diacritics well, try to stick
to ASCII characters only.

The next step is segmenting the recording to prepare it for transcription and annotation...
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To open Segmentation Mode, click the Options menu, then select ‘Segmentation Mode’. You

should see something like this:

2 ELAN 5.2 - Undefined File Name — O g

File Edit Annotation Tier Type Search View Options Window Help

Segmentation | Controls |

® Two keystrokes per annotation (non-adjacent annotations)
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Segmentation Key. Enter
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” oo 00:00:01.000 00:00:02.000 00:00:03.000

A_Transcription-txt-yaa

Interlinear-title-yaa

I A_Transcription-bd-yaa

[4]

410 ] Iy = ——=

0o:00:04000 | %

In Segmentation
Mode, you can
change the
preferences for
how you want to
create your
segments.

This tutorial will
show how to
make non-
adjacent
annotations,
which is what
many
fieldworkers use
for monologic
speech or
elicited speech.

Different fieldworkers may prefer to use two keystrokes (i.e., press Enter to start and press Enter
again to end) or a single keystroke (i.e., press and hold Enter for the duration of the segment).
Segments can be created while the recording is playing in ELAN or while it is paused. Using the
two keystroke method, you can mark the beginning of a segment, play or pause as necessary,

then mark the end of that segment.
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Once some segments have been created, the window should look like this:

(TR RO DEDEDIDI] (P[] Doz @ Hovering over a segment
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= i i ! i L
=

will turn it green. To
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S B
00:00:05.000 =

I over the vertical bars and

A_Transcription-txt-yaa

— drag left/right.

If a whole segment needs to be moved, hover over the horizontal bar and drag and drop into

position.

1.3 Transcription Mode

Once some or all of the segments have been created, Transcription Mode can be used to create
transcriptions, translations or other annotations. To open Transcription Mode, click the Options
menu, then select ‘Transcription Mode’. This will open a window like this:

File Edit Annotation Tier Type Search View Options Window Help
| 00:00:00 000 @no..|
Gy FAAREETT N o By casatrda |

[EI [ps] ] L] Loop Mode

! Time Interval: 00:00:00.000 - 00:00:00.000 0 % Transcription mode settings X

| ho.ooo " oo:00:05.000
Font size |13 |v|
Number of columns | 3|i|+ =]
Column Select type for column
1 Phrases
2 Mote

— 3 <select a type=

Settings

| [] Automatic playback of media

i [¥] Create missing annotations

[¥] Show tier names

l [] Colors only on "No." column
[] Navigate across column
[_] Scroll current annotation to center

Configure...

| [selecttiers... | Apply | | cancel
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To set up a new transcription, you select the ‘types’ that correspond to the appropriate tiers in
your template.

Phrases corresponds to material in the study language and Notes to material in the contact
language.

The number of columns, including the blank column 3 shown above, can be adjusted by clicking
the +/- buttons. Remove column 3 using the ‘- key and click ‘Apply’. Transcription Mode
should look something like this:

2€ ELAN 5.2 - Undefined File Name = [l x
i
File Edit Anpotation Tier Type Search View Options Window Help
D _No | Type 1:Phrases I Type 2 Note
d 1 - '
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Time Interwal: 00:00:00.170 - 00:00:02.383 2213 1 ii: B R o) [CEIHTGH
bdio 000001000 000002000 5
3
B ] 4
5
Volume 100
L ) B
Rate 100 7
o)
I it
Settings
e =
[_| Automatic playback of media =
s =
[v] Create missing annotations |' |

To get started, click on the first line and hit the tab key to play. Transcribe what you hear!

Enter a translation or other note in additional columns if desired (as shown). The following
section describes tier structure and templates in more detail.

The settings can be changed to automatically play media when you navigate to a new line by
selecting the ‘Automatic playback of media’ check box.

Complete your transcription/annotations and don’t forget to save periodically!
2 Tier structure and templates in ELAN

ELAN annotations consist of one or more tiers. A tier may consist of a transcription, a
translation, metadata, notes/tags of interesting phenomena, or other information. This section
describes some of the ways that tier attributes can be modified and tier structures organized to
create a customized template for the types of annotations that a fieldworker may need to make.
In particular, this section presents how to design a tier structure template that allows data to be
exported to FLEx, and how to modify this basic structure for annotating multi-participant
interaction.
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2.1 An introduction to tiers and their attributes

Tiers can be organized in nested, parent-child relationships where child tiers can be set to
automatically inherit certain properties from the parent tiers. For example, a very minimal tier
structure like the one exemplified below may consist of just two tiers: a parent tier with a
transcription and a dependent tier with a translation, with the translation tier inheriting the time-
alignment (segmentation) properties of the parent.

I 00.000 00:00:02.000 00:00:04.000 00:00:06.000

. | Adu fitis hiwukia | fitrakia bae wits | Ait
A_Transcription-txt-yaa | |
[40j
cuento de majas una persona ha hecho chacra cl

A_Translation-gls-es
[140]

A more complicated template might include a metadata tier (“Interlinear” in the example
below”), tiers for notes, and use nested structure to represent the speech of multiple participants.

" 1.000 00:00:40.000 00:00:42.000 00:00:44.000

— Interlinear-title-yaa
o}

s ya esta ya ma, ma akamé nu ¢
7 L_Transcription-txt-yaa
237

yayaesta los

— L_Translation-gls-es
(701

— L_SpeechType-note-en
]

. . uiki tae wain(
B Mari_Transcription-txt-yaa }_V—{
[665]

) . 0 primero voy a contg
— Mari- Translation-gls-es yop Y
[550]

— Mari_SpeechType-note-en
141

et Jlidado heni enesis ma aka, awara fiana duku yuipe, fiana awaisi, nii chitt
i Mech_Transcription-txt-yaa }-9—{ }—-— Yuip! |
[333]

ya esta cuenta nos algo gue cosa? de |

— Mech_Translation-gls-es
[243]

— Mech_SpeechType-note-en
11

(5 K Transcription-txtyaa Iya he apagado fideo ya} Iya fideo ya esta } Ia, la, el pollo falta poquitito I
1zl

— K_Translation-gls-es
]

— K_SpeechType-note-en
0]

In this tutorial, we are going to use a template with the following generalized structure:

Purpose Label Relationships

Metadata tier: Interlinear-title-xxx Parent-level, no dependent
Transcription: A_Transcription-txt-xxx Parent of translation
Translation: A Translation-gls-yyy Dependent of translation

This guide discusses the naming conventions of these tiers (which facilitate export to FLEX) in
section 3. If FLEX is not part of your workflow, you could also just label them “Metadata”,
“Transcription”, and “Translation”.
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Tiers in ELAN can have different properties (e.g. time-alignable vs. not-time-alignable) and can
have different relationships to each other (e.g. symbolic association, symbolic sub-division).
Each tier in ELAN must correspond to a type, which are customizable bundles of these property
and relationship values.

The tiers that we use in this guide have the following types:

Type Type attributes Corresponding tier Tier purpose
Text no stereotype, time-alignable Interlinear-title-xxx Metadata
Phrases no stereotype, time-alignable A_Transcription-txt-xxx Transcription
Note symbolic association, A Translation-gls-yyy Translation

not time-alignable

This set of types will allow us to import data into FLEx, specifically the text title from the
metadata tier, the baseline from the transcription tier, and the free translation from the translation
tier.

2.2 Customizing types and tier attributes

Tiers can be customized in a number of ways, ranging from major changes in the structure and
function (e.g., changing type attributes or parent-child dependencies) to minor, aesthetic changes
(e.g., the color of the tier). This section provides an overview of the ways tiers and tier structures
can be customized.

% Change Tier Attributes X . . .
To change tier attributes, click

Change Tier Attributes “Tier” in the menu bar, then

St T “Change Tier Attributes”. This
Tier Name | Parent Tier | Tier Type | Participant | Annotator |Input Method Content La... . .
A_Transcri...|- Phrases A 5 = will open this pop-up menu.
Interlinear-ti..|- Text - -
A Translati../A Transcri... |Note A - - The “Change Tier Attributes”
menu allows the user to change:

The tier name

[ Add rChange | Delete | Import |

| e The participant label
SRS T IA-T“mf"f"°"'“‘*“ =l . The annotator label
Tier Name A_Transcription-txt-yaa | o The parent Of the tier
Participant |A | K
R anotstor | .| e The type of the tier
Parent Tier none |,| e The input method and content
e T [Phesses ] language (optional)
o [None ] o 'll“he tler‘ colcl)r and highlight
Content Language iNune- - iv| color (Optlona )
‘:‘ e The tier font (will need to be

s Qntiones changed to match the font in

| Change ‘ | Close FLEx before export)
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Tier names

A good tier name is descriptive and gives a reader other than the annotator an indication of the
contents of the tier. In the case of the tiers used in this guide, the names take forms like
“A_Transcription-txt-yaa”. In this example tier name, there are four parts:

e ‘A’ is a participant label indicating the identity of the speaker (this can be changed to any
string, e.g. KCN or Kelsey — participant labels and the annotation of multi-party
interaction is discussed more later),

e ‘Transcription’ is the descriptive element indicating the nature of the contents,

e ‘txt’ isused by ELAN in the FLEx import process, discussed more later, and

e ‘yaa’ is the FLEX internal language code (in this case identical to the ISO code) for
Yaminawa, the (primary) language of the contents in this case.

Participant and annotator labels

Participant labels identify the speaker in the metadata and are particularly useful for the
annotation of multi-participant speech. The identity of the participant can also be identified in the
name of the tier, as described above.

One handy feature of ELAN for annotating multi-party interaction is the “Add new participant”
menu under the “Tier” menu. This feature allows the user to copy a parent tier and its
dependent’s structure, specifying a new participant in the metadata and changing either a
prefixed or suffixed participant label in the tier name. In the example below, the tier structure
under the parent “A_Transcription-txt-yaa” is copied, the participant label is changed to
“Kelsey” and the prefix ‘A_’ on the tiers is changed to ‘K ’.

2€ Add new participant N

Interlinear-title-yaa

—————— Add new participant
A_Transcription-ixt-yaa Select

(0] = =

® tier structure ([ participant

A_Translation-gls-es
1]

|[¥] A_Transcription-txt-yaa
|

Options

Specify the new participant: Kelsey |

Specify whether the suffix or prefix of the selected tier structure(s} to be changed
® prefix

) suffix

Enter the value to be replaced |A |

Enter the new value for replacement |ﬂ_ |

[
‘ oK ‘| Close ‘

(Upon clicking ‘OK’ ELAN will give you a “process report” to tell you that it executed the
change — just click ‘OK’ to close.)
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The annotator label allows the user to specify the identity of the person who annotated a
particular tier — potentially useful for projects involving multiple researchers, students, or where
speakers use ELAN themselves to perform transcription and translation tasks.

Parent of the tier
A newly created tier can be assigned as a dependent of another tier by selecting the parent tier
from the drop down menu.

Type of the tier

This drop down menu allows the user to change the type of the tier. To create a new type or to
change the properties of a type, click ‘Type’ on the menu bar, then either “Add New Tier Type”
or “Change Tier Type” (once the pop-up opens, both are available by clicking tabs).

2% Add Type X

Add Type

Current Types

Type Name Stereotype Use Controlled Vocabulary| DCID | Time-alignable
Text - -

Phrases
default-It -
Words Symbolic Subdivision |-
Note Symbolic Association |-
Blank Symbolic Association |-

[NE R RESESES

" Add | Change " Delete | Import ‘

Type Name N ew| |

Stereotype INone | v ‘

Use Controlled Vocabulary |None | - |

Lexicon connection + | |
1SO Data Category e ‘ .

Time-alignable V]

‘ Add H Close ‘

There are five stereotypes for available for types:

e Symbolic association — for dependent tiers; the segmentation is copied from a parent tier

e Symbolic subdivision — for dependent tiers; the segmentation is copied from a parent tier
and can be divided into equal-sized sub units

¢ Time subdivision — for dependent tiers; the segmentation is copied from a parent tier and
can be divided into time-alignable sub-units (must be contiguous!)

e Included in — for dependent tiers that are also parent tiers; used to create gaps between
the top-level parent tier and lower tiers (e.g., where there is a silence — see Tacchetti’s
2018 manual for ELAN)

e None — for independent or parent tiers
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The check box toward the bottom of the pop-up allows the user to specify if the tier is time-
alignable or not. Generally, only top-level parent tiers will be time-alignable.

There are a number of other optional attributes that can be specified for a tier type. A Controlled
vocabulary is a pre-set list of values that can be used in annotations, particularly useful for
ensuring consistency for tag-type annotations. See Tacchetti’s 2018 manual for more on how to
set these up and use them. A Lexicon connection is used when data is interlinearized using
ELAN’s (new!) interlinearization mode, which is not covered here. The ISO data category can
be added to include extra metadata in the tier, if desired.

Input method and content language

The Input Method drop down menu in the “Change Tier Attributes” pop-up allows the user to
choose the keyboard that will be used in that tier, allowing you to switch seamlessly between two
virtual keyboards (e.g., IPA and English International). The Content language drop down
allows the user to specify the (primary) language used in the tier.

Tier font, color, and highlight
Clicking the “More Options...” button in the “Change Tier Attributes” pop-up opens another
pop-up with further, mostly aesthetic options.

Change Tier Attributes x

Tier Name: A_Transcription-txt-yaa

Tier Preferences

Tier Color . | Browse... | ‘ Default ‘

Tier Highlight ‘ ‘ | Browse.. : | Default ‘
EE— L L

T I

Tier Font | Browse.. ! | Default |

| Apply || Cancel ‘

Tier color and Tier highlight are entirely aesthetic, but they can be useful for improving
readability or making certain tiers stand out in particularly complex tier structures.

Tier font is important for the ELAN to FLEx export process, as the same font and encoding must
be used in the .eaf file as in the FLEX file in order to avoid encoding problems with punctuation,
etc. Changing the tier font through this menu changes all the annotations in the tier, so it is
possible to use one font for annotating, and then change it to the FLEx font when the annotations
are complete. Section 3 details how to find the font used in FLEx.

Finally, notice that in addition to adding and changing tiers in the pop-up, tiers may also be
deleted. Be sure to click “Add”, “Change”, or “Delete” (as relevant) before switching to a
different tab in the pop-up or before hitting “Close”. These buttons will apply the changes you
make immediately, and you can see the tier structure change if Annotation Mode is open in the
background of the pop-up.
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23 Saving a tier structure as a template

Once you have developed a tier structure that works for your project, you can save it as a
template that can be loaded for future annotations. Just click on “File” = “Save as template”.
Make sure to give the file a descriptive name and select a folder/location that is easy for you to
locate in the future. If you use multiple templates, you can even save them in different folders
corresponding to the different data types they are intended for (e.g., stimuli responses vs.
naturalistic speech, monologic vs. multi-party speech).

Template files have the extension .etf, whereas annotations linked to specific media have
the extension .eaf.

Another useful tool in ELAN is the “Import Tier” feature under the “Tier” menu. This feature
can copy tiers from either an .eaf (annotation) or .etf (template) file to be used in a new/modified
tier structure.

24 Using complex tier structures

One of the strengths of ELAN for creating annotations is the handling of overlapping speech of
different participants in multi-party interaction. As we saw in section 2.1, ELAN permits a
bundle of tiers for each participant, and makes it easy to visualize their overlaps and temporal
organization in Annotation Mode. Transcription Mode makes transcription and translation of
multi-party speech easier for the linguist and the consultant by chronologically ordering the
annotations across different participants, as seen below.

2 ELAN 5.6-FX - Yaminawa_2016-11-04_LAW+MML+MMS_KCN_0538.eaf — | >
Eile Edit Annotation Ter Type Search View Options Window Help
HEEEE No Type 1 : Phrases Type 2 - Note
] I | S ,S/| [] Loop Mode |
—'——l—l'—' o Mech_Transcription-txt-yaa Mech_Translation-gls-es =
Hmeinietval BEl0. 45 315 =MEN-10 570 2o 14 ma aka, awara fiaia duku yuipe, fiand ya esta cuenta nos algo
i)ﬂm)allﬁl)l)()
Mari_Transcription-txt-yaa Mari_Translation-gls-es
15 | yuiki tae waini Y0 primero voy a contar
= sy siparmnen bl
Mech Transcription-txt-yaa Mech Translation-gls-es
16 awatsi, nl chitudawa wawuna que cosa? de los mashco piros
Volume 100
Q L_Transcription-txt-yaa L_Translation-gls-es
Rue m 17 |nu chitunawal los mashcos
; . ]
Settings Mech_Transcription-txt-yaa Mech_Translation-gls-es
_ 18 atu akitawu vamos a contar lo que la pasado
|_| Automatic playback of media
[] Create missing annotations Mari_Transcription-txt-yaa Mari_Translation-gls-es
[v] Show tier names 19 wanimé wanimé, atu tsaiki aver donde, donde es que vamos a conversar
- - Mech Transcription-txt-yaa Mech_Translation-gls-es
|| Navigate across column
- 20 ejé, da, diri shara uwé si, este, ven mas acacito
|| Scroll current annotation to center
Configure... ‘ L_Transcription-txt-yaa L_Translation-gls-es |
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Automatic color coding of different participants makes it easy to identify which speaker you are
transcribing. The color can also be customized in the Tier attributes menu, as described above.
The chronological ordering of the tiers makes it easier to work with native speakers to transcribe
overlapping speech, which is notoriously difficult.

If you use a complex structure that involves tiers that contain annotations beyond just the
standard transcription and translation kind, there are some potential pit-falls that can avoided by
thoughtfully designing your tier structure.

e Ifyou use multiple dependent tiers that have the same tier type attribute, this can cause
you to have difficulty selecting which tier of that type you want to appear in Translation
Mode. This is commonly an issue with a type like “Note” used in the examples here. To
avoid this, make a type with identical attributes but give it a different type name. In this
way, you can precisely select which tier(s) you want displayed in Translation Mode.

e Ifyou use a tier structure that has annotations at the parent level that you do not want to
include in Transcription mode (for example, tiers containing the linguist’s speech, or
parent-level notes), you can de-select those top-level parent tiers by clicking
“Configure” = “Select tiers...” = (de)select relevant tiers = “Apply” = “Apply”.

Volume 100

Rate 100
; ‘b, |
Settings
[ ] Automatic playback of media

[¢] Create missing annotations

|7_I Show tier names

[ | Navigate across column

[ | Scroll current annotation to center

Configure...

46 a chakata doko xakiki aka, no, datiro doko puku pia akaki
|
' | dika
Font size 12 ‘ - ‘
T
Number of columns | 22!@|j| :
Column Select type for column
1 Phrases
2 Note
% Select tiers pad
| S Show / Hide T_.[Top Level Tier_ | Type 1 : Phra._| Type 2 - Note
[v] L_Transcripti_.|L_Transcriptio. |l_Translation...
Do reauvs p
4 Mari_Transcri. |Mari_Transcn.|Mari_Translat..
Mech_T1 ([¢] Mech_Transc.|Mech Transc..|Mech Transt...
54  |[uninte] | }[] K_Transcripti .|\K_Transcripti . |K_Translaticn
55  |ewetiru wy L] X Transeripti | X_Transcripfi.|X_Translation
‘ Apply ‘ ‘ Cancel ‘

Mari_Transcription-txt-yaa

| %

Mari_Tra
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3 Exporting from ELAN to FLEx

This section explains how to export an ELAN .eaf annotation file to a .flextext file that can be
imported to FLEx for interlinearization. In order to attempt the steps described in this section you
will need the following:

1) both ELAN and FLEXx installed on your computer,

2) an ELAN .eaf annotation file with a completed transcription and translation, and
3) a FLEx database set up for the study language, with the writing system configured.
3.1  Before you start the export

Before starting the export process, you will need to check some things in your ELAN annotation
and in your FLEx database to avoid errors.

1) The ELAN .eaf file that you want to export should be more or less complete -- make sure that
the transcription and translation are “finished” (meaning you are mostly confident in your
phonological analysis and ready to start interlinearizing).

2) Minimally, the tier structure should have the following three tiers:

o Metadata (top-level)

o Transcription (top-level)

—>Translation (dependent of Transcription)

The tier structure may have additional tiers and this should not cause any problems as long as
they have different tier types than “Text”, “Phrases”, and “Note” which are used for the export
(see section 2). In the event that you use the same tier types for additional tiers, you will want to
make sure during the steps of the export process that you select the correct ones (one of the three
above).

3) Unfortunately, the export does not work well for multi-party interaction and will not add
participant labels for individual lines in FLEX, as FLEX is designed for use with monologic texts
only. In version 5 of ELAN, an Interlinear Mode was introduced, and this seems like a promising
avenue for researchers interested in interlinearizing conversation in a structured way.

4) The minimal three tiers listed above should have the appropriate suffixes to their names:

e the metadata tier should end in ‘-title-xxx’,

e the transcription tier should end in ‘-txt-xxx’, and

e the translation tier should end in ‘gls-yyy’,
where ‘xxx’ is the FLEx internal code for the vernacular/study language and ‘yyy’ is the internal
code for the analysis/contact language.

5) The font used by the transcription and translation tiers must be the same as the font specified
in the “Writing Systems” settings in FLEX.



To check for the font and language internal
codes in FLEXx, click “Tools” (in the menu
bar) > “Configure” - “Set up Writing
Systems”. This will open a pop-up like
this:

In FLEX, the “vernacular” language refers
to the language being studied and the
“analysis” language(s) refer to the
language(s) used as a contact language or
for other levels of analysis.

Writing System Properties
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FieldWorks Project Properties
General Writing Systems  Linked Files

\Writing systems defined for this project are shown below. Check
those which you want to appear in multilingual. single-line fields
The first checked writing system is the default for its type

Vernacular Writing Systems

ad ~
Modify...
Hide
v e

Analysis \Writing Systems

CE N id -

[] English
Modify. ..
Hide
hd -~

OK Cancel Help

. . . Language:

fhghhghtln%a Name: Ethnologue code: yaa Change...
anguage an

. g ] g Yaminahuia | Ethnologue entry for yaa
clicking the
“Modify...” button ﬁ;‘;’; iﬁ:;:}sm eimicivag | O Font  Keyboard Conveders Sotng Characters
to the right of it setveviaton: [Yon
opens another pop- Usually, you only need to use the following fields in order to distinguish writing

. systems for the same language.
up window that
displays the FLEx Script name: . Script Abbreviation (4 char.)
lntemal language Region name: Region abbreviation (2 or 3 char )
code used to oy
1dent1fy each Variant name: Variant abbreviation:
language. This is | ]
Direction: Spelling dictionary:
usually, but not ® Lok soight = .
always, the same as O Right-to-left
Ad - Copy - Internal Code: yasa

the ISO code for
the language.

Cancel

Help

Clicking on the “Font” tab displays the font used in FLEx for the language. Make a note of the
font(s) and of the Internal codes of the vernacular and contact analysis language. Change the
tier names to include the language codes and change the tier fonts to match FLEXx (as

described in section 2.2).




3.2

The export process
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Once you have changed the tier names to include the language codes and changed the tier fonts
to match FLEX, you are ready to begin the export process. To begin the export click “File” =
“Export as” = “FLEXx file”. This will open a pop-up that will guide you through the .eaf to
flextext export process.

% Export as FLEx file

Step 1/4: Element Mapping

Element Mapping

Export interlinear-text tier |Interlinear-title-yaa |Y |
[ | Export paragraph tier
FLEx Element Name Corresponding Tier Type
paragraph
phrase Phrases
word No linked types available
morph No linked types available

Select tiers to be exported

The pop-up should automatically select your translation tier for export.

2€ Export as FLEx file

Step 2/4: Element-ltem Configuration

paragraph phrase word morph
[¥] A_Transcription-txt...
Pres ‘ Next ‘I Finish Cancel ‘

Make sure the “Export
Interlinear-text tier” box
is checked and select your
metadata tier (in this case
“Interlinear-title-yaa”)
from the drop down.

Doing so will
automatically populate
the Transcription tier (of
the type ‘phrase’) in the
bottom boxes where tiers
are selected for export.

When this step is
complete, click “Next”.

x  Ifnot, go back and
check in your tier
structure that the
transcription tier is

|a Select a tier type for 'morph-type’ tiers

Item Mapping

the parent of the
translation tier, and

interlinear-text_item

phrase_item

word_item

morph_item

that transcription has

No linked types available

Mote

No linked types available

No linked types available

the type “Phrases”

No linked types available

Mo linked types available

and translation has

Select tiers to be exported

the type “Note”.

interlinear-text_item

phrase_item

word_itermn

morph_item

morph-type

| A_Translation...

When this step is

Previous ‘ ‘

Next

Finish 1 Cancel ‘

complete, click
“Next”.
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In the third step, check that the types and languages are correct.

2 Export as FLEx file

X

Step 3/4: Element-item "type' and 'lang’ attribute configuration

Specify the value for type and lang attribute based on

@ tier O tier type
TierName type language
interlinear-text
Interlinear-title-yaa title yaa
phrase
A Transcription-txt-yaa |xt yaa

A Translation-gls-es  |gls

e5

word

morph

Type-Lang value configuration

Add/remove values for

Add custom value

Select the value to be removed ‘-:select:'

@ type O language

|‘ Add

"| ‘ Remove ‘

Previous ‘ ‘ Next

‘ Cancel ‘

26 Export as FLEx file

Step 4/4: Save as

Select destination file

Browse...

Previous ||

2 Export as FLEx file

Step 4/4: Save as

Select destination file Usersikelse\Desktoplexample flextext BiniwaEs

=
=

Previous ||

Finish H Cancel ‘

The type and language values are
based on the suffixed information in
the tier names. The “title” and “txt”
types should be in the study language
and the “gls” type should be in the
analysis/contact language. The
language codes must match those used
by FLEX, as described in 3.1.

The “title” type will go in the title
field of the FLEX text, the “txt” type
will go in the baseline, and the “gls”
type will go in the “free translation”
line associated with each line of the
baseline in FLEX.

When you have checked that the types
and language codes are correct, click
“Next”.

In the final step, click “Browse...” to
choose a location for the exported file
and to give it a name.

Click “Finish” to complete the
export. The flextext file will now
appear in the folder you indicated.

example.fle..
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33 The import process

Once the .eaf file has been exported to a .flextext file, you can begin the import side of the
process in FLEx. Navigate to the “Texts & Words” tab at the bottom left corner, and select
“Interlinear Texts” at the list on the top left.

&2 Yaminawa - FieldWorks Language Explorer - O X

File Send/Receive Edit View Data Inset Format Tools Parser Window Help

QO |X| ey x @ hﬂ & = Eﬂ @ k- @ E % | | Yaminahua v -
Texts & Words | Text
Interinear Texts i (B i fam - — - .
Ca nwd:n; ]Ts'ﬂhe = = S o Shidipawawé kashta nashiwu widi
B Complex Concordance = SP7  Hombre antiguo se ha reunido con alma de carachupa
HAWord List Concordance | Pai wake
B Word Analyses = Info  Baselne Gloss Analyze Tagging Print View Text Chart
: ) st
%:* Edt Wordfoms 1 Word Iskadikia . 8
atistics ol Tl
Riwi ndshiwu Morphemes iska di =kia
Ruapitsi Lex Entries iska ~di =kia
Ruawu dawawu Lex Gloss hacerasiPROX PASREM EVIDREP
& Lexicon Riniwa fishiwu Free Asi dice ha dicho.
(@) Texts &Words | Rapita 2 Word Dii Kai
(7 Grammar Shidipawawé kashta fashiwu widi Morphemes dii ka i
) Notebook Titka Lex. Entries dii ka
E List Tua fishiwu Lex Gloss monte irse SG IPFV
ol . Free Estaba yendo al monte. e
W
19/5ep/2019  Queue: (-/-/~) No Parser Loaded Sorted by Titie. 34/50

In the menu bar, click “File” = “Import” = “FLEx Text Interlinear...”.

FieldWorks interlinear (FLExText) file Click “Browse...”, navigate to
the folder wher th

Import from the FLExText interinear export format. Cumrently this process imports only the baseline and e folder where you saved the

free translations. t makes no changes to the lexicon. flextext ﬁle, and select the
file.

FLExText file:

C:\Users \kelse'\Desktop \example flextext | [ Browse.. ]

OK | | Cancel | | Help. Click “OK”.
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The text will now appear in the list of texts, using the title specified in the metadata tier. Each
segment in the .eaf file will be imported as a numbered line in the .flextext, with the translation
appearing in the baseline (the material listed next to “Word” in the Analyze tab), and the
translation appearing in the Free Translation line (the material listed next to “Free” in the
Analyze tab).

ﬂ? Yaminawa - FieldWorks Language Explorer = O x
File Send/Receive Edit View Data Inset Format Tools Parser Window Help
OO X e 6:’ H= o =2 Fﬂ @ EB E’: A .S;.‘Jn:sh *| Default Pera.grd.p.h -
Texts & Words [Texts — | Text
Intedfinear Texts Ti (e i — . g
Concordance || E‘Irow T R o Y aminawa_ishpawawe-xokadi MRR_0051
3 Complex Concordance | |
3 Word List Concordance Wedsak )
: i Info Baseline Gloss alyze¢ Tagging Print View Text Chart
B Word Analyses edeuba rawe : Analy
:J"‘ Edy Wordfomns Wuipapi 1 Word Ishpawawé xukadi . n
atistics
Wupa nashiwu Morphemes *** oy
Xeki fiishiwu Lex. Entries *** Rz
i o Lex. Gloss *** .y
..... Xete nashiwu
Free El gente que raton ha pelado.
0 Eeotione Xukuxukuika nashiwu . " .
@ Texts & Words | v iniwa fishiwu 2 Word Ishpawawe xukadiwi awiya
[% Grammar Xuya fishiwu Morphemes *** s awt =ya
,g"‘_\ l.. E tl'i ok ek e — s
[ Notebook Y = ~ ex. Ccnmes awl ya
aminawa_ishpawawe-
ﬁ — MR-R 6’:51 Lex. Gloss *** e esposa POS
= | Lists X g =
Free Ishpawawe Xokadi tenia su mujer. i
_ |« > wi
24/Sep/2013  Queue: (-/-/-) No Parser Loaded Sorted by Title 49/51

The text is now ready to be interlinearized and analyzed in FLEx! FLEx allows you to export
interlinearized texts back to a .flextext file (for import back to ELAN or to other FLEx projects),
as html, xml, or an OpenOffice .odt file. To export the texts from FLEX, click “File”—> “Export
Interlinear...” while in the “Texts & Words” tab with “Interlinear Texts” selected. Formats like
XML can be further parsed by Python scripts to be output to other formats like LaTeX.

4 Using ELAN with Praat

ELAN can be used with Praat in two ways: opening audio from ELAN directly in Praat, and the
import/export of annotations between .eaf and . TextGrid format. This section briefly covers how
to use ELAN in workflows that involve the use of Praat.

4.1 Viewing audio from ELAN in Praat

ELAN can be linked with Praat to allow you to open selections or make clips in Praat directly
from the waveform in ELAN. In order to do this, you will need the following:

1) ELAN installed, with a media file opened

2) Praat downloaded (http://www.fon.hum.uva.nl/praat/)

3) SendPraat downloaded (http://www.fon.hum.uva.nl/praat/sendpraat.html)
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I recommend putting the SendPraat executable in the same place as the Praat executable — for
most people this is usually right on the desktop.

In ELAN, select a portion of the waveform as shown below and right-click to open the menu.
This will give you various options for viewing the material in Praat.

2 ELAN 56-FX - Yaminawa_ishpawawe-xokadi_MRR_005.., = O bt

File Edit Annotation Tier Type Search View Options Window Help

| Comments Recognizers f Metadata Controls Zoom »
. erd [ Tex | Subtitles ' Vertical Zoom »
‘ Select Metadata Source... ‘ No metadata source selected. Stereo Channeis

¥ Time Ruler Visible

¥ Connected to Other Viewers with a Time Scale

00:04:10.709

- i Open File in Praat
] 14 | F | = F|M |
- LYE, i—.‘” LiLb iﬁ[ PELPLLY ‘ﬂJ Open Selection in Praat
= — Clip Selection with Praat

h__bl—-_l-_l—__ﬂ = .
Clip Selection...

lYaminawa_(shpawawe-:okadi..‘ ‘v 00:04:10.000 Segmentation b
Player Info...

Copy Non-adjusted Media Time (ignores offset)

A &;ﬁ?iﬁ--ﬁsinf- =iijil~- —

- i-lli. T T |“-I. T T T T T T T T | T T I.I -
" 00:04:10.000 00:04:12.000

Interlinear-title-yaa
(]

| Minia disapaketd, disjpaketd, ede waté W

Han rallado platano, Tm rallado, ¥ han h H

[« [I] [y] =)

A_Transcription-txt-yaa
[754]

A Translation-gls-es I
F231 [w

“Open File in Praat” opens the whole media file in Praat. “Open Selection in Praat” loads the
whole media file in Praat, but the window opens centered and zoomed in on the portion that you
select in ELAN.“Clip Selection in Praat” works like “Open Selection in Praat”, but it takes the
extra step of clipping the selection from the rest of the media recording. Note that the file will
still need to be saved as a .WAYV or other format from Praat.

The first time that you attempt one of these three options, ELAN will take you through a short
dialogue to select the locations of Praat and the SendPraat executable. It’s just that easy!

These same options are also offered if you select part of the waveform in the small window in
ELAN’s Transcription Mode pane.
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4.2 Importing and Exporting to/from Praat TextGrids
ELAN allows both import from and export to Praat TextGrid files.

ELAN makes transcription very fast, but Praat has some capabilities like clipping and scripts that
make it very useful for linguists, particularly interested in phonetic detail. To export an .eaf
transcription to a .TextGrid transcription, open the .eaf in ELAN, then click “File” = “Export
as” - “Praat TextGrid”. This will open a window like this:

2 Export as Praat TextGrid b4
Export as Praat TextGrid
Select tiers
| By Tier Names [’ By Types [’ By Participants r By Annotators i By Languages Select the tiers that
; Interlinear-title-yaa you want to be
é Transcription-txt-yaa exported to the
\¥| Phonetic-note-yaa .
¥l Translation-gls-es TextGrid.
[ ] Show only root tiers
‘ A ‘ BN ‘ A-Z ‘ | Undosort | | Select All ‘ ‘ Select None
Output options
[] Restrict to selected time interval
[] Add master media time offset to annotation times
Click “OK”.
‘ OK ‘ ‘ Close ‘
% Export as Praat TextGrid % Select a location for the TextGrid
- file, name it, and click “Save”.
Saveln: |[] Desktop - | |E| B=
] CLA transcriptions [ ELDP Post-award
] Contracts [ Fieldwork
4] I | [*

File Name |Yaminawa_2[}1 3-06-20 JRR_KCN_ 0001 w1 |

Note that encoding is sometimes an

File Format ‘Praat TextGrid files (. TextGrid) ‘ - ‘ issue — ELAN gives you the option
to output as UTF-8 or UTF-16.
Enceding: UTF-8 | v Praat is usually set to read UTF-8.

(You can check this in Praat by
clicking “File”-> “Preferences”—>
“Text reading preferences”.)

‘ Save H Cancel |
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You can now open the TextGrid and audio file in Praat. As you can see below, the hierarchical
structure of tiers in ELAN is flattened in a TextGrid representation.

B 1. TextGrid Yaminawa_2013-06-20_JRR_KCN_0001_v1 = O >
File Edit Query View Select Interval Boundary Tier Spectrum Pitch Intensity Formant Pulses Help
63.446576
0.809 i

0548 " " W

(To see the analyses, zoom in to at most 15 seconds

or raise the “longest analysis” setting with “Show analyses” in the View menu.)

e I ma peda I ma peda Fﬁpe U Transcription-ij
(7/1401)
2 I ma'pida I malpida Im:a'pi:da C ;I;%r;?tIC-note-
3 i}uenos ch.asl Ibuenos dias Ibuenos U_ (l;:gj ;mon-gls
16.690575
46.756002 [46.756002 Visible part 17.443287 seconds 64.199289| 6122 516711

Total duration 6186.716000 seconds
a | n | oul sellbaklﬂj jWGrﬂm

It is also possible to import TextGrids as .eaf files in ELAN. This can be useful for researchers
who started out transcribing in Praat and switched to ELAN, and who want to put all of their
transcriptions in the same format. To do this, click “File”—> “Import”—> “Praat TextGrid
File”.This will open a pop-up dialogue that asks you to choose the TextGrid file that you want to
import. Clicking “Browse...” will open a dialogue box to select it:

by Select.. X

Look In ; "j i ‘ '| EliF== Select the file you want to import.

[ Practical Materials and Scripts

1l test
[ Tutorials Remember to check the encoding, and be
7 Local Disk (D) - Shortcut sure that it matches the format that Praat

[} Yaminawa_2013-06-20_JRR_KCN_0001_vi.TextGrid  writes to. You can check this in Praat by
clicking “File”-> “Preferences” = “Text
writing preferences”.

4 | i [»

File Name |Yaminawa 2013-06-20 JRR._ KCN 0001 v1_TextGrid|

File Format ‘Praat TextGrid files (*. TextGrid) ‘ v |

Encoding: |UTF-8 :

‘ Open... H Cancel ‘

When you have done this, click “Open”.




September 2019

2 Praat TextGrid File.. X
ELAN gives you the
Select a Praat TextGrid file containing Interval tiers Option to include
PointTiers and to
celse\DesktoptY aminawa_2013-06-20_JRR_KCN_0001_v1 TextGrid Browse... Skip empty intervals.

In most cases, you
will want to Skip

Include Praat PointTiers .
N empty intervals.

.
iEl Default PointTier annotation duration (ms)

[ | Skip empty intervals [ annotations

| Previous | Next Finish Cancel Click “Next”.
This will open the next window in the dialogue.

% Praat TexiGrid File... % Choose a tier type
for your tiers to be
imported as.

Select a tier type:

Because TextGrids
have a flat structure,
Type Name Stereotype Use Controlled Vocabulary, yF)u will c?nly be
G B I given options for
Phrases = - types with the
Text = - stereotype “none”.

Previous MNext ‘ Finish Cancel Click “Finish”.
You should now be able to see your annotations:
Il ' Lt} T LI o L [} LA U ' roa ! LER | LI L] LT 1
00:00:48.000 00:00:50.000 00:00:52.000 00:00:54.000
Transcription-txt-yvaa e Al
]
Phonetic-note-yaa o o [
[729]
W buenos dias buenos dias
Translation-gls-es
261

Finally, make sure to save the file!



